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     স হ            স     - ২০২৪ 
            ক      স    

1. GPT stands for- 
A. General Pre-trained transformer 
B. Generative Program Technology 
C. Generative Process technology  

D. Generative Pre-trained Transformer  

2. ক                      হ  ক      ? 

A.  স  ক  B.              

C. ক         D.               
 ক    গ             স     - ২০২৪ 

            ক      স    
3.                    ক? 

A.          হ  হ   B.          হ    ক 

C.         হ D.  ক           

         ও স         গ - ২০২৪ 
   স সহ  ক 

4.                     ক   স খ           হ   ক   হ ? 

A.         B.     ক 

C.  ক    D.  হ     স      
5.         ক    ক? 

A. গ     ক স      ক    

B.       ক          স গ        ক   
C.   খ  ও       খ      

D.       ক            

         স ক     হ  ক      - ২০২৪ 
সহক          ক (          ) 

6. Domain Name System (DNS)-   ক   ক ? 

A. ও   স    ক     স      খ  
B. Domain Name- ক IP Address       ক   
C.       হ                 ক    

D.          ক   স   হ            
7. HTML-          ক ? 

A. Hyper Text Markup Language 
B. Hyper Text Makeup Language 
C. Hyperlinked Textual Mapping Language 

D. Hierarchical Textual Markup Link   

                ক      - ২০২৪ 
ও    হ  স/ও     স          

8.  ক             স             স (Time Slice) 
        স   ক   হ ? 

A.       স      B.            

C.              D.                
  ক        - ২০২৪ 

                  স 
9. (1101)2        ক স খ   ক ? 

A. ৯ B. ১১ 

C. ১২ D. ১৩   
10. IPv4           ক     Google DNS Server IP 

Address? 

A. 8.8.7.6 B. 8.7.8.6 
C. 8.8.8.6 D. 8.8.8.8  

11. Paypal is a- 

A. Bank  

B. Online Money Transfer Service 
C. Currier Service  

D. Mobile Banking Service  

12. https    s       ক       ? 

A. security B. special 
C. secured D. system  

                             (BREB) – ২০২৪  
সহক                     

13. An XOR gate produces an output only when 

its two inputs are - 

A. high B. low 
C. different D. same  

 স    স        ক      ,       – ২০২৪  
     সহক    

14.                ক       হ   MMS      হ ? 

A.     B.       

C.       D.         
15. E-mail        হ  ক  স   ? 

A. ১৯৭০ B. ১৯৭১ 

C. ১৯৭৩ D. ১৯৭৪   

পিএসপস ও অন্যান্য পন্য় াগ িরীক্ষার প্রশ্নাবপ঱ (জানু্ াপর – পিয়সম্ব , ২০২৪) 
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                  – ২০২৪ 
  -সহক      ক     

16.                      হ  - 
A.            স    B.       স    

C. ক        স    D.          স     
ঔষ     স         – ২০২৪ 

   স সহ  ক 
17. ক            স হ   - 

A.  ক           ষ ক              
B. ক                 ক   ও     স  ক   

C. ক          ক          স  ক        ক   ক    

D. ক                            ক  খ    
  ও         ক                      – ২০২৪  

  -সহক      ক     
18.  ক        স         ও             স  হ স   

      হ ? 

A. Scanner B. Mouse 
C. Touch Screen D. Projector   

19. Which is not part of Processing Unit? 

A. Arithmetic Unit B. Logical Unit 
C. Execution Unit D. Memory  

  ও         ক                    . – ২০২৪ 
সহক      ক    /      ক  

20.  ক   ক            ক  ক ? 

A. ০ B. ১০০ 

C. ১৫০ D. ২০০   
21. 3             NAND  গ      ক         1 হ   

       ক ? 

A. 0 B. 3 

C. 1 D.  ক            
স    ক      ও ক               – ২০২৪ 

          ক 
22.                     ক সহ       খ         ক    

     ক   স  ও        হ   ক   হ ? 

A.         B.        

C. ও       স স  D.            

১৮       ক             (         ) – ২০২৪ 
23. ক          ক ক                -     ক ক  

    হ ? 

A.         B.     ক  

C.  -     D.           
             – ২০২৪ 

    গ  ক  ক    
24. ক            স ক ? 

A.  ক      ক  ক         

B.  ক      ক  ক স  ক    
C.  ক      ক  ক      স  

D.  ক      ক  ক          
25. GPRS-          ক ? 

A. General Packet Radio Service 

B. Global Protect Radiation Service 
C. General Preference Radio Service  

D. Global Packet Reminder Service  

26.             ক  ক? 

A. Charles Babej B. Vinton Gray Cerf 
C. Vinton Gray D. Bill Gates  

           স    ক             ক      – ২০২৪ 
   স সহক    ক   ক              ক 

27.  স  -                      ক  ক  ও স  ও     
     ক     গ    ক                    হ ? 

A.  স     B.          

C.        D.         
28. ও       সস    ক  ও  ক            স     

ক     ক   ক         হ   ক   হ ? 

A.     B. ও    

C.  স  D.  স         

29.            ক     ক           স     গ   ? 

A. ২ B. ৩ 

C. ৪ D. ৫  

30.                  হ   সহ    ক  ও     খ          
 ক        হ   ক   হ ? 

A.         B.        

C. ও       স স  D.            
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31. স  ও           ক   ক    ? 

A. ২ B. ৩ 

C. ৪ D. ৫   
32. ক        ১  ক        হ ? 

A. ১০২৪ B. ১০২৮ 

C. ১০০০ D. ১০১২   
            ও   – ২০২৪ 

   ক  ক      
33.        ক         'Pay as you go' স    স      

   স   ক  ? 

A. Internet of Things  

B. Cloud Computing 
C. Client Server System  

D. Big Data Analysis   
         স ক    ক   ক     – ২০২৪ 

Home Economist (       ) 
34. ১          (TB) স   - 

A. ১০২৪   গ      B. ১০২৪            

C. ১০২৪  গগ      D. ১০২৪  ক          
     ক              গ       – ২০২৪ 

সহক       ক 
35. AI    স    ক     স ক    ? 

A. 4 IR B. Digital device 

C. Cloud server D. স        
36. ‘SIM’           ক ? 

A. Spot identity module 
B. Small initiative module 
C. Single intenssive module  

D. Subscriber identity module   

         ক   স   স      ক           স – ২০২৪  
স  -               

37. Firewall  ক protection   ও              হ ? 

A. Fire attack B. Virus attack 
C. Unauthorized access D. Data-driven attack   

38. ক                      হ   ক     ? 

A.  স  ক  B.              

C. গ        D.              

         স ক    ক  ক     – ২০২৪  
 স           স  

39.             খ       ক           হ ? 

A. স     B. স      
C.        D. ক       
 
  

Janata Bank PLC - 2024 
Rural Credit Officer 

40. A computer network which is used within a 

building is called a- 

 A. WAN B. MAN 
 C. LAN D. SAN   

41. Which of these refers to the PowerPoint view 

used for displaying only the text (title and 

bullets)? 

 A. Slide sorter show B. Slide view 
 C. Outline view D. Notes page view   

42. Which of these is a type of sound file? 

 A. DAT files B. LOG files 
 C. DRV Files D. WAV Files   
43. To insert chart in MS Excel, which shortcut 

key is used? 

 A. Alt+F1  B. F2 
 C. F3 D. F4  
44. Which of the following computer language is 

written in binary codes only? 

 A. Pascal B. Machine Language 
 C. C D. C+  

45. Who among the following is considered as the 

inventor of the World Wide Web (WWW)? 

 A. Edward Kasner B. Bill Gates 
 C. Tim Berners Lee D. George C. Devol   

46. URL stands for- 

 A. Universal Resource Location  
 B. Universal Resource Locator 
 C. Unified Response Location  

 D. Uniform Resource Locator   

47. Which one of the following is not a web 

browser? 

 A. Firefox B. Facebook 
 C. Chrome D. Safari   

48. Process of finding and correcting errors is 

known as- 

 A. Bugs B. Debugging 
 C. Hacking D. Cracking   

বযাাংক পন্য় াগ িরীক্ষার প্রশ্নাবপ঱ 
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49. A socially intelligent humanoid robot, Sophia, 
was developed by which of the following 
country? 

 A. USA B. Hong-Kong 
 C. Japan D. Germany    

Combined 7 Banks - 2024 
Officer Cash 

50. In MICR, 'C' stands for - 
A. Character B. Code 
C. Color D. Computer  

51. What is the meaning of OMR? 
A. Optical Mark Reader  
B. Optical Message Reader 
C. Optical Message Render  
D. Optical Mark Render    

52. _____ is the common language for Al. 
A. Lisp B. Java 
C. PHP D. Python  

53. Which of the following is not a valid data type 
in MS-Excel? 
A. Number B. Label 
C. Character D. Date/Time  

54. In MS-Word, CTRL+E will result in - 
A. Table B. Centre alignment 
C. Exit from MS word D. Underlined text  

55. Word processing, spreadsheet, and photo-
editing are examples of- 
A. Application Software  
B. System Software 
C. Web Development Software  
D. Platform Software   

56. In order to save a Word document as a web 
page you need to - 
A. Put the appropriate graphics and links on the 

document  
B. Save the document in simple text format 
C. Use your web browser as an editor and save as 

URL  
D. Save as HTML    

57. Which of the following will translate images of 
text, drawings, and photos into digital form? 
A. Digitizer B. Modem 
C. Scanner D. Keyboard   

58. A pixel is - 
A. Computer program that draws picture  
B. Picture stored in the secondary memory 
C. The smallest resolvable part of a picture 
D. Virus    

59. Ctrl, Shift and Alt are called _____ keys. 
A. Alphanumeric B. Modifier 
C. Adjustment D. Function   

স     ১০     ক ও     ক        – ২০২৪ 
   স   (       ) 

60. Bitcoins are created as a reward for a process 
known as- 
A. mining B. wallet 
C. bubble D. ledger   

61. Which of the following is a function of NPSB? 
A. Establishing interoperability among banks for 

transaction  
B. Establishing interoperability among mobile 

financial service providers 
C. Allowing instantancous transfer of money 
D. Allowing interoperability among banks and 

mobile financial service providers   
62. Different banks of Bangladesh introduced 

Mobile Apps (Android version) for providing 
online financial services to its customers. 
Which of the following Mobile Apps have been 
launched by the scheduled banks? 
A. bKash, MTB Smart Banking, iPay and 

Paytouch  
B. UPAY, iPay, Nagad, FastPay and NexusPay 

 C. NexusPay, CellFin, Citytouch, UPAY and 
SKYBANKING  

 D. CellFin, IPay, Nagad, FastPay, Citytouch    
63. Which Memory has the highest speed of 

access? 
A. RAM B. Cache 
C. Hard Disk D. CD   

64. Who owns the Java programming language? 
A. Oracle Corporation  
B. Microsoft Corporation  
C. Sun Microsystems  
D. IBM    

65. ABACUS is- 
A. A hand operated calculating tool  
B. A database management system 
C. A programming language 
D. An antivirus software   

66. Number of different characters in ASCII 
coding system is- 
A. 128 B. 2048 
C. 4096 D. 8192  

67. Which key board command is used to 
underline a word or sentence is Ms Word? 
A. Alt+U B. Ctrl+U 
C. Alt+L D. Ctrl+Alt+U    

68. Which of the following is not an image/ 
graphic file format? 
A. PNG B. GIF 
C. BMP D. GUI  

69. Cyber Security Act was enacted in Bangladesh 
in the year- 
A. 2018 B. 2020 
C. 2022 D. 2023 
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  ও                      স 
        : ক   গ   সহ  ক/   স সহ  ক 

1. Which device is called Sillico Sapiens? 

A. Monitor B. Hardware  

C. Computer D. Robot  
2. ক                  গ       ক              ষ  

     - হ ? 
A.      স B.        

C.      D.  ক          
3. ক -        '     -ক ' ক   ? 

A. ৮   B. ১০    
C. ১২   D. ১৪    

4. স       ক    স    স    ক          ক স  স  
    হ         ? 
A. ROM        B. RAM         
C. AG        D. VG         

5.        ক     ক                    স? 
A.       B.   ক    
C.       D.    স  

6.        ক               স    স  ও        ? 
A. C B. DOS  

C. LINUX D. XENIX  
7. ক            হ   - 

A.       B. হ        
C.        D.         সস   
  ক     স         ক        . (        )  

        :    ক                
8. IOT      ক ? 

A. Internet of Technologies  

B. Internet of Things  

C. Internet of Transmission  
D. Internet of Technologies  

9. MS Word -   ক        Document  খ         
 ক   key combination    হ   ক    হ  ? 

A. Ctrl+W B. Shift+N  

C. Ctrl+N D. Alt++N  
10. LINUX ক ? 

A. Malware B. Operating System  

C. Application Program D. Firmware  

11.  ক    -      'CC'        ক ? 

A. Close Circuit B. Carbon Copy  

C. Close Contact D. Close Copy  
12. MS Excel   স  ক        খ          ক    ? 

A. Sum (C9:C12) B. Sum(C9+C12)   

C. Sum =(C9:C12) D. =Sum (C9:C12)  
13. MS Word   'λ'           ক             ? 

A. Insert >Symbol B. Tools>Symbol  

C. Macro> Symbol D. Format > Symbol  
14. PostScript হ     ক  - 

A.       B.         
C.           ষ  D.  ক          

  ও                      স 
        :         হস   সহক    

1.      ক      ক    ? 
 A.     B. স     

 C.     D.        

2. স        ক                      ক         
            হ ?  

 A. VSAT B.        

 C.    ক     D.     ক            

3. ক            স  ক?  
 A.  ক      ক  ক         
 B.  ক      ক  ক স  ক     

 C.  ক      ক  ক      স  

 D.  ক      ক  ক         
4. ক                          ক   স  ও       

          গ ? 
 A.    স    স B.   ও          

 C.    স      D.           

5. ক -         ক   Key-   স       Help Key  হ স   
      হ ?  

 A. F12 B. F5   

 C. F1 D. F2  

6. ক       হ   ক     ক    ক    – 
 A. Virus B. Backup  

 C. Antivirus D. Firewall  
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7.     ক                   ক   ঘ      ঘ  ?  
 A.    স   B.         

 C.        D.                 

8.  ক   গ  ষ  গ    স     ক           ক   
   ও   ক  স    ? 

 A. LAN B. MAN  

 C. WAN D. PAN  

9.         ক                   স   ? 
 A.        ক B.        ক  

 C.      D.  ক          
10.                     হ    ক ঘ  ? 
 A. ক           হ         

 B. ক         গ              

 C.         স ক   ক       

 D.               ক           

11.  ক                স  ও    ?  
 A.    স ও     B.    স    স  

 C.       স        D.    স   ও         
12.                      স    গ         হ   ক   হ  –  
 A. Dial-Up B. Satellite  

 C. Modem D. DSL  

13.             ক     ক   ক  ?  
 A.        ক      B.   ক              

 C.    ক    ক      D.        ক  স স      

Uttara Bank PLC 
Post: Probationary Officer 

15. What is the artificial intelligence developed by 

Google? 

A. Bird B. Gemini  

C. GPT D. Hix AI  
    ক               স     ||  

        :             ক      স    
16. ক                হ   ক                      

            ক    - 
 A.                 

 B.      গ  স  

C. হ                  ও  গ   
 D.  গ    

                                 
        :     ক  হ     

17.  ক     Input      স   ? 
 A. Mouse B. Keyboard  

C. Monitor D. Microphone  
18. WiFi           ক ? 
 A. Wireless Firewall B. Wireless Fider  

C. Wireless Firefox D. Wireless Fidelity   
19.        ক     Browser Software? 

A. WORD B. PUBLISHER  

C. EDGE D. AVRO  
20. WiFi Network -   স     গ      স     

     স    স    গ        ক    ? 
 A.    হ   স    গ B.     ক            

C.           D.       স ক      
21. VIRUS           ক ? 
 A. Various Information Resources Under Stolen  

B. Various Information resources Under Siege  

C. Vital Information Resources Under Siege  
 D. Vital Information resources Under Stolen  
22. Computer      ষ  ক ? 
 A.  হ     স    B.       

C.     ক D.           
SBAC Bank PLC 

Post: Trainee Junior Officer 

23. Electronic payment system is a(n) ________. 

 A. Software B. Package  

C. Application D. Hardware  
24. The fourth industrial revolution is termed as 

A. Industry 4.01 B. Industry 4.1  

C. Industry 4.04 D. Industry 4.4   
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SpaceX Starship 
                   SpaceX’         ক         স                   স           (স      হ        -     
স খ   ৩৩  ) স                      স                          হ     গ    ক ।       স    হ            ক    
৪          হও       ৫      স   হ  ১৩       , ২০২৪।   স         স   ক                            ।  
     স     ক   ক   হ ক    ক     ক          ক           ক   স          স      হ                  স 
  ও     (  ও              ক   খ  ‘    ক’         )।      হ (    হ,     )      ষ   স                ও    
     গ    ক             ক       ক    । 
 SpaceX:    ক    হ ক         ক  ক      হ ক         স       ক          ।  

স        ক                   ।      ক    ১৪       ২০০২। 
 SpaceX Dragon 2:  হ ক                       ক  হ ক             ষ ও         হ  ক  । 
 Starlink:           স             ক          স     ক          । 
 Neuralink:      ষ         স        স    গ            Brain Computer Interfaces (BCIs)  

                ক           ক।               ষ           হ            ক   ২৯           ২০২৪।  
       ক   ক    BCIs                            ক ক         স  ক         ক      ,         সহ       
          ক       ক        ।                    ক                                ক   ক      ।  

           স     ক    গ    গ               
                 ক    ১৪  গ   ২০১৩।      ক                             ক               হ           ক ।  
                                 স ও  ও    ক          -        ।                                       

                 হ  ক                      গ     গ  স         ।                ক          । 
     স             স            ক       ক   ২৪  গ   ২০২৪                        । 
   ক    ক   (   ক):               স     ক    গ    গ             ক    ২০০৬ স   ।    স              স  ক 
 হ স                 ক।          ক            ক         ক    হ   ক            স                     
                ক   ।            ক            হ  ক                 হ           ও               ।  ক  
            খ    ক  ।        স ক     স   স ক     হ ।         ক   স ও       ক স             হ ।      
 খ     ক  স             ক                  ।            ক    স ক                     হ । 

‘   -     ’ স             
              AI           স   ক স       ক  :            স   । 
     ক    ক               ক  :     ক           । 
       স            ক    ৫        ১  –        (Luna 2 – 1959), ২  –        (Surveyor 1 – 1959), ৩  –     

(Chang’e 3 – 2013), ৪   –      (Chandrayaan-3 – 2023), ৫  –       (SLIM – 2024). 
 ৬        স      ক        ।                        স স  ও     ক  স         ষ  ক         । 
       স               ক       ১ .          (GPU, AI                           ); ২ .       স    ৩ .      । 
  গ    Gmail            হ স           Xmail       ঘ ষ      । 
   ঘ                              স                  হ    ক  স    ক      ক   গ       । 

কপিউটার ও তথ্য-প্রযুপি সাংপিষ্ট সাম্প্রপতক তথ্যাবপ঱ 
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                    হ ও          স   হ ‘ ক   -১’   ক         ক           । 
                     স               ক         স                      গ    গ       ক     (       স  – 

১১       ২০২৪।      হ  ক            ,             ও      ক।     ও        –  সহ স        ও      স 
         স                       । 

 ‘      ’       ২০২৪ স           ক           ষ     ক                 হ                ।              
              ক         ক   খ ক     ও স    ক         ক   হ                              । 

     ও    গ    গ           স         গ        গ      ক                ক               ‘  -   ’      ক   ৩ 
       ২০২৪ (www.gbrainbd.ai)। 

 ‘        ’                     সহক            ‘LLaMA (Large Language Model Meta AI)’            
     স          ক       । ‘Llama 3.1’                             স              স    । ও    
 স স     ক হও               ক       গ                                   ক             ক           । 
                           ক। 

  গ    স            ক    ‘স         ’      OpenAi। 
 Virtual Private Network (VPN)        ক            স       ১৯৯৬ । 
 ক            স           ও  স                  স       হ   ক    হ                   ।              

 স                    স     হ      ৫০০ ও                   ক           ক     গ ।       স            
    স                                         ক           ক                 গ       । 

   -      স     স    ক স        সক     
         (           ):    ২৮     ১৯৭১          ক            স  স          ।         ও     ক    

          স   –     ক  ক গ                       স-   –   হ ক              ও       ক             
        ক (Neuralink – developing implantable brain–computer interfaces),         গ  স    X (স   ক 
       ।                zip2। সহ-       : Pay-Pal         : X.com) 

                    ক    ২৭         ২০২২  ৪৪                ৪৪০০  ক          ।                     X. 

   গ    Happening now. X            হ স     ক    ক    গ  Threads        ক    ৫        ২০২৩।  
                      হ   Facebook, Instagram, Threads and WhatsApp.    স  ক  ক                   

ক   ‘    ’    ক   ক   হ   ২৮         ২০২১।                স            ক স।              :   ক   কস। 
       স              স     ক                             স ক  স     ক       । 
          স    ক স     স  ক                                  ও                   গ      হ । 
    ক      স                হ      হ   স ‘   স ও      স         ’            ৪.৬         ৪৬০০ 

       ৪৬০  ক                     ক   ক    ১২        ২০২২। 
 International Space Station (ISS)             ক           ক        হ।         হ ক   গ  ষ   স    

স               ক  । ৫   স    হ  : NASA, Roscosmos, JAEA, CSA & ESA (Europe).        ২০২৪ 
স        ISS    ক স     স                 ক  হ ক             ক   । 

     ক                স  স             ক          স               ক     । 
HP                হ স   HP         ও      স ক                      ক  । 
                 AI    । 

 


